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Keyboard Shortcuts

Ctrl + Space - Play / Stop 

Ctrl + Left - Previous Word			   |	 Ctrl + Right - Next Word

Ctrl + Shift + Up OR [Delete]: Merge Line	 |	 Ctrl + Shift + Down OR [Enter}: Split Line 

Up Arrow: Change Capitalization  		 |	 Down Arrow: Change Capitalization

Ctrl + Up: Previous Speaker			   |	 Ctrl + Down: Next Speaker

Ctrl + Backspace: Delete Word		  |	 Ctrl + Delete: Delete Word

Ctrl + Shift + Backspace: Delete Punctuations

Ctrl + Z: Undo					     |	 Ctrl + Shift + Z: Redo

MAC USERS: Undo is Control + Z. (Premiere sees Command + Z as Undo for it’s functions)

Punctuation Shortcuts:

Period:			  .		  Left Single Quote:	 ‘			    
Comma:		  , 		  Right Single Quote:	 Command/CTRL + ‘ 
Question Mark: 	 ?		  Left Double Quote:	 Shift + “ 
Exclamation Point:	 !		  Right Double Quote:	 Cmd/CTRL + Shift + “ 
Colon:			   :		  Semi-Colon:		  ; 
Left Parenthesis:	 (		  Right Parenthesis:	 )

Delete Word: Backspace/Delete	 Delete Punctuation: Cmd/CTRL+Backspace
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About This Manual

While the manual is a good resource, we recommend checking out the videos on Transcriptive to 
really get an understanding of how it works. Often it’s easier to show something than to try to explain it 
with words, especially with something that’s visual to begin with.

However, it can be hard to go into lots of detail in a video, so this manual usually provides more info 
than you’ll find in the tutorial videos. The videos and manual are designed to complement each other.

Here are the tutorial videos, they’re all aournd 4-5 minutes or less:

New feature overview: 
https://youtu.be/wuVMDdXL5Cs

Clip Mode and Editing Video with Text: 
 https://youtu.be/KVUt2IOR4-c

Alignment: Syncing transcripts/scripts to text 
https://youtu.be/nAdZEdS8akI

New Text Editor: 
https://youtu.be/NkjLpl6iW9Y

PowerSearch Tutorials 
https://digitalanarchy.com/premiere-search/tutes.html

Additional videos and training: 
https://digitalanarchy.com/transcribe-video/tutes.html
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Installation

You can always download the most up-to-date version of Transcriptive from our Demo page. Your serial number will activate 
the demo.

Mac Demo:

https://digitalanarchy.com/demos/psd_mac.html

Download the .dmg file and run the Installer that’s on the dmg.

This will install the Transcriptive panel and associated files into: 
Macintosh HD/Library/Application Support/Adobe/CEP/

It will also install the FLAC exporter into: 
Macintosh HD/Library/Application Support/Adobe/Common/Plugins/7.0/MediaCore/Digital Anarchy

Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close 
the installer.

Restart Premiere Pro and Transcriptive should show up in Premiere under Windows>Extensions>Transcriptive 

If at some point you wish to uninstall Transcriptive completely (this is sometimes helpful in troubleshooting problems with a new 
version), run the Un-Installer. 

Windows Demo:

https://digitalanarchy.com/demos/psd_win.html

Open the .zip file and launch the Transcriptve_Installer.exe. If you are updating or upgrading, you’ll be asked if you 
want to uninstall Transcriptive. Click OK to run the un-installer. (highly recommended)

Click through the installer, agreeing to the license terms. The installer will automatically select the correct directory, 
don’t change this unless you have an unusual system and you know where the panel should go.

This will install the Transcriptive panel, Premiere Power Search panel and associated files into: 
C:\Program Files\Adobe\Adobe Premiere Pro CC 2017\CEP\extensions

It will also install the FLAC exporter into: 
C:\Program Files\Adobe\Common\Plug-ins\7.0\MediaCore\Digital Anarchy

Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close 
the installer.

Restart Premiere Pro and Transcriptive should show up in Premiere under Windows>Extensions>Transcriptive

If at some point you wish to uninstall Transcriptive completely (this is sometimes helpful in troubleshooting problems with a new 
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Licensing and Activating Transcriptive

Licensing Transcriptive is significantly different than it was previously.

You can register the panel with your serial number or by logging in with your Transcriptive.com 
account. If you log in with your Transcriptive.com account, once you link a serial number to it, you 
don’t need to remember the number. Just log in and you’re good to go.

You can also deactivate other computers or manage all your licenses in one place.

Of course, if you have any problems with licensing, please email us at cs@digitalanarchy.com or call 
1-415-287-6069. Phone support is: 10a-5p PST, Mon-Fri. Email support is seven days a week.

Some problems can be solved by deleting the license file. This is located at:

Windows: C:\Users\Public\Documents\Digital Anarchy\Receipts
Mac: Main Hardrive\Users\Shared\Digital Anarchy\Receipts

Activating

When you launch Transcriptive for the first time, you’ll see a dialog like this:

You can either: 

1) Enter the credentials for your Transcriptive.com account 
2) Click on the ‘Click here to register with just your serial number’ link… this will let you enter your 
serial number and be on your way.
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There are some advantages to #1. If you enter your Transcriptive.com credentials, you’ll need to link 
your serial number to your account. You only need to do this once. After that you can log in anywhere 
and your license will follow you.

Just using your serial number is a bit faster initially, but in the long run, just logging into your account 
and not having to always find the serial number could be easier. 

You can use your license on up to two computers.

Deactivating

You’re allowed to use Transcriptive on two computers. If you go over that and try to use a third 
computer, you’ll get a message saying you’ve logged into to too many computer and will need to 
deactivate them.

Just select ‘Deactivate all other machines’ and you’ll be able to log in.
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Setting Up Your Transcription Account

You must set up an account on Transcriptive.com in order to transcribe. It’s free but you need to enter 
in a credit card to cover the transcription costs ($0.06-0.12/min).

Just go to https://app.transcriptive.com and you’ll see this screen:

Select ‘create a New Transcriptive Account’ and enter in your information.

Once that’s created, you’ll be able to enter your credentials in the Premiere panel and you’ll be good 
to go to transcribe!

To enter the credentials in the Premiere panel, go to the Account dropdown in the upper, right corner. 
Just click the Login button and put in your account info.
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What is Transcriptive?

Transcriptive is a new way of automatically transcribing video and audio. Making it simple 
to search the video, create subtitles, closed captions, and more. We allow you to use 
two different Artificial Intelligence/Machine Learning services to achieve unprecedented 
automatic accuracy. Why two? It makes it more cost effective as you can choose the 
appropriate algorithm for the quality of your audio. The two differ in cost and accuracy… see 
the How It Works section for complete details. (Transcriptive-A.I. is the more accurate service 
but costs a bit more)

Once the  transcript is processed it then becomes available in Premiere to be edited, 
searched, saved out to markers, or exported as a caption file. You can search the text either 
in the Transcriptive window or Premiere’s metadata panel, making it easier than ever to find 
where something was said in your video. 

You can also import an existing script or transcript and sync that to the audio! Transcriptive 
will add time code to every word, allowing you to easily search the text and jump to the 
corresponding place on the Premiere timeline. This is now free for English and can be 
done offline! See the section on Alignment.

Exported files can be taken into any other application or used in Premiere Pro. Common uses 
are for closed captions, sub-titles, and SEO for YouTube.

How it works? 

Transcriptive will transcribe any clip selected in the Project panel, the active sequence, or you 
can batch process multiple clips. You select what you want to transcribe, set in and out points 
if necessary, and open the Transcriptive panel and click TRANSCRIBE.

If you’re batch processing, select the appropriate Batch command from the Main Menu and 
select your files.

You’ll then be asked what Speech Engine you want to use, Transcriptive-A.I. or Transcriptive-
Speechmatics. (see the Speech Engine Setup section for more details on using Speechmatics)

You’ll need to sign up for a Transcriptive.com account and enter your credentials into 
Transcriptive. This will let you use either speech service.

Why do we make you do this?

It’s for your benefit actually. It allows you to select the service that meets your needs. The 
accuracy and cost of the two services differ. Transcriptive-A.I. is more accurate but costs 
more. Speechmatics is good but less accurate (especially with punctuation) and costs a bit 
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less. For very well recorded audio, there’s not a lot of difference between the two. For audio 
that’s lower quality (background noise, accents, poor enunciation), Transcriptive-A.I. is better.

What are the costs?*

As of this writing (December 2019), the costs were as follows:

Transcriptive A.I. : $0.12/min 

Transcriptive-Speechmatics: $0.06/min. One change with Transcriptive 2.0 is that all 
transcribing goes through your Transcriptive.com account. This means you’ll be charged in 
dollars for both services (Speechmatics used to be in Pounds).

Speechmatics: Until January 1, 2020, you’ll be able to use Speechmatics with a 
Speechmatics account. After that you’ll only be able to use it through your Transcriptive 
account. If you have a lot of Speechmatics minutes please contact us to transition them. You 
won’t be able to use them after Dec. 31, 2019.

Transcriptive Human: $1.50/min (via Transcriptive.com, not available in the Premiere panel)

* The Digital Anarchy website will also show the most up to date pricing. (we try to keep the 
manuals up-to-date but it doesn’t always happen)

Which Speech Algorithm Should I Use?

If your audio is poorly recorded, there’s a lot of background noise or heavy accents, you may 
want to consider using the Transcriptive-Human service. A.I. has it’s limits and the poorer the 
recording the worse it’s going to do. 

As for the AI services, Transcriptive-A.I. will usually be the most accurate, especially if you 
consider punctuation which Speechmatics currently doesn’t do. We’re constantly testing an 
array of speech-to-text services and will use whichever is currently best based on the settings 
you choose. The service we use may change based on several factors including whether 
Speaker Identification is turned on or what language you choose. This is a pay-as-you-go 
service, so you just pay for the minutes as you use them. So it’s a pretty easy option.

Speechmatics will also give you very good results. It has about 96% accuracy on clean 
audio. It also doesn’t do punctuation other than periods. It’s less expensive than the 
Transcriptive-A.I.

If you have a lot of background noise or accents, Transcriptive-A.I. is probably your best 
bet. It’s almost always going to be the most accurate with that type of audio. Speechmatics is 
great for clean audio but the accuracy falls off more steeply as the audio quality gets worse.
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If you’re just using the speech-to-text to allow you to search your video and jump to where the 
text is spoken, Speechmatics is a good choice. Yes, it’s somewhat less accurate but if you’re just 
trying to search a lot of video it’s a good option as it’s a bit cheaper than the Transcriptive-A.I.

If you’re creating captions and you need 100% accuracy, the less accurate the A.I. is, the 
longer it’ll take you to clean things up. So Transcriptive-A.I. or even Transcriptive-Human is 
probably what will work best.

Of course, we strongly suggest you run a few tests on your own video footage with varying 
audio quality to see the results yourself. We’ve found the above to hold true for the vast 
majority of tests we’ve run. However, your tests, with your audio, will tell you which service is 
best for you as there are plenty of exceptions. For example, Speechmatics will often handle 
accents a bit better than Transcriptive A.I. as much of their training data comes from the UK 
and EU.

System Requirements

Transcriptive requires an internet connection. The only way around this is to use a different 
computer to upload the audio file and get the transcript. You can then move the resulting 
transcript file to the original computer and import it into Transcriptive. It’s easy but is a bit more 
work. (see Importing JSON Files for more info)

You can also import a text file (e.g. human created transcript) and use the Alignment feature 
to sync the text and your audio up. For English, Alignment works offline and is free. So that’s 
workaround for the internet requirement. 

You MUST sign up for a free account on Transcriptive.com and enter in your credit card. You 
can then enter your credentials in the panel and that will allow you to transcribe. Your credit 
card is only used for charging you for the transcription minutes you use.

Premiere Pro 2019 or later. To address some bugs with Premiere we had to require 2019 
for 2.0. We always support the most recent version of Creative Cloud, so Transcriptive should 
work whenever a new version is released.
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Transcription Basics and User Interface

Launching Transcriptive

You can launch Transcriptive by going to:

Window>Extensions>Transcriptive

This will open the Transcriptive panel. Feel free to dock the panel anywhere in the Premiere 
Pro workspace. You can also leave it as a floating window.

First Thing...

The first thing you’ll need to do is to enter in your Transcriptive.com credentials so you can 
transcribe. You can access both Transcriptive-A.I. and Speechmatics with this single account. 
Just go to Transcriptive.com to set up an account and then you can enter that into the panel, 
like so:
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Signing Up with Transcriptive A.I.

Transcriptive A.I. : You’ll need to create an account on Transcriptive.com. Go to the Account 
menu in the Transcriptive Panel and click Register. This will take you to App.Transcriptive.com 
where you can set up an account and enter in a credit card number. 

   
	       Transcriptive Panel 				    App.Transcriptive.com

After creating the account, go back to the Premiere panel and login. You should know 
see Transcriptive and Speechmatics as an option in the ‘Transcribe With’ dropdown in the 
Transcribe dialog.

You should be all set! Go forth and transcribe!

Beauty Box
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Original

Beauty Box

Can I use YouTube or Facebook to get free transcription?

Yes. This blog post explains how to do both. YouTube is easy, Facebook... not so much:

https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-or-
youtube-creates/ 

If you have a Google Pixel phone, the new Recorder app they released with the Pixel 4 has 
built-in transcription that’s really excellent. Just import the text and audio file into Transcriptive 
and use the Alignment feature!

Speech Engine Setup

This dialog is no longer as important as it used to be.

For Transcriptive A.I. and Speechmatics, all you need to do is log into your Transcriptive.com 
account. Nothing else is needed. You can do this in this dialog or under the Account menu.

For Speechmatics, this is only relevent if you’re using their On-Premise solution. You can enter 
in your credential information by going to the Speechmatics tab in Speech Engine Setup. 

On January 1st, 2020 this will stop working with Speechmatics.com accounts.

If you want to set up Speechmatics on your own in-house server, please contact  
sales@digitalanarchy.com for more information on their On-Premise solution.

https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-or-youtube-creates/
https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-or-youtube-creates/
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Critical Things to Know

Clicking on The Transcriptive Panel

In order for Transcriptive to work, you have to click on the Transcriptive panel. If you just select 
your sequence and hit play, Transcriptive won’t do anything. This is a limitation of Premiere. 
You have to select the Transcriptive panel and hit play from within Transcriptive otherwise 
Transcriptive won’t have any idea what Premiere is doing. Transcriptive is technically a 
separate app running within Premiere. It will communicate with Premiere but not vice versa. 
So control Premiere from within Transcriptive, it won’t work otherwise.

Clip Mode vs Sequence Mode: 

Please review the section on Clip Mode and Sequence Mode. It’s central to how the panel 
works. In Clip Mode, you are editing the transcripts for individual clips that you select in 
the Project panel. This is your Master Transcript. If you turn Clip Mode off, you’re now in 
Sequence Mode. This will show the transcript for the active sequence. Editing this only affects 
the transcript for that sequence. It does not get saved to the individual clips. Again, see the 
section on Clip vs. Sequence Mode and how the transcript data is saved.

Accuracy: 

Both Transcriptive A.I. and Speechmatics are very accurate. However, background noise 
and unclear speaking can make it harder for the speech services to figure out what’s being 
said. The less noise you have and the better your talent enunciates words, the higher the 
accuracy will be. Make sure your talent is mic’d, speaks clearly and any background 
noise is minimized. Talent that has a heavy accent or is off mic will get transcribed with less 
accuracy (sometimes significantly less) than talent that is mic’d and well spoken. Regardless, 
Transcriptive A.I. is usually the better Speech Service, especially with recordings that have a 
lot of background noise. However, we definitely recommend doing some tests with your own 
audio.

Undo/Redo (especially Mac folks):

You can also use Control+Z for Undo and Control+Shift+Z for Redo. NOTE: On the Mac it 
is also Control+Z. As a Premiere panel we can’t use Command+Z as a normal application 
would. To Mac OS, Premiere is the active application, so Command+Z undoes Premiere 
functions which doesn’t include the Transcriptive panel.



20 © 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Intro & Basics
 Transforming Transcripts, Search & Editing

Maximum Length of transcript: 

Both Speech Services support transcripts of any length. However, very long transcripts can 
affect performance.

Complete info about Captions can be found on Page 51 and 60.

Open Captions:

To create open captions in Premiere, we recommend you export the transcript as SRT. You can 
then import that into Premiere if you need to make small adjustments using the Captions panel, 
or if you want to export them baked into your video. You can also use SMPTE or VTT.

Closed Captions: 

To create closed captions in Premiere, you need to export the transcript as either SMPTE-TT, 
SCC, or MCC. You can then import them into Premiere if you need to make small adjustments 
using the Captions panel, or if you want to export them baked into your video. 

Clip Mode Vs. Sequence Mode

There’s not a lot to this. When Transcriptive is in Clip Mode, you’ll see the transcripts for clips 
in the Project Panel or selected in a sequence. When it’s in Sequence Mode, you’ll see the 
transcripts for the active sequence. 
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Still blotchy, needs more smoothing.

However, when you’re editing a transcript, it REALLY matters what mode you’re in.

Clip Mode is usually the Master Transcript. When you make edits in Clip Mode, those edits 
get saved to the Clip’s metadata. What you see in Clip Mode is what will get used when 
you drop a clip into a sequence. If you edit the transcript in a sequence, that edit does not 
get saved with the clip permanently unless you Export>Speech Analysis. Export>Speech 
Analysis, when you’re in Sequence Mode, will save the transcript to the Clip’s metadata, thus 
making it permanent.

We do this because you might edit the text in a sequence in a way that you would not want to 
affect the permanent transcript. For example, in sequence I might delete a bunch of lines from 
the transcript but I don’t want them permanently deleted from the Clip’s transcript.

For more info on how we save data in sidecar files, XMP data and the Premiere project, see 
the next section.
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JSON side car files (vs. Speech analysis)

One of the big new things is how transcripts get saved when they come back from the A.I. 
Service and when they get edited. We save the transcript to Speech Analysis XML (as we did 
in TS 1.0) but we also create a JSON file that lives next to your media clip.

This is partially because of the new Clip Mode. Previously, clips had to be in a sequence to 
get a transcript and when the transcript was edited, that got saved with the sequence. With 
Clip Mode, you can transcribe and edit the transcript of a clip by itself, so… where do we 
save it?

XMP Metadata / Speech Analysis: As in TS 1.0, whenever you submit something to be 
transcribed and we get a transcript back, the transcript gets saved in Speech Analysis, which 
is an XMP field that you can find in the Metadata panel. This is where we save a ‘backup’ of 
the transcript. The only way this can get overwritten is if you go to Export>Speech Analysis 
and manually tell Transcriptive to save the transcript in the panel into Speech Analysis. (when 
you finish cleaning up a transcript, we do recommend you do that. That’ll permanently save 
your edits with the clip’s metadata)

JSON Sidecar File: This is what’s new. When you get a transcript back for a clip, we also 
save a JSON file next to your media file. When you make edits to the transcript, those are 
saved into this JSON file. So if you’re moving a piece of footage around or saving a backup, 
make sure the JSON file goes with it. 

This allows you to make edits to a transcript and still revert back to the original in Speech 
Analysis if something goes wrong.

Sequence’s Transcript: Also, if you add a clip to a sequence, there’s a transcript for that 
sequence that’s different than anything saved at the Clip level. Any changes you make to 
the Sequence’s transcript DOES NOT get saved to the Clip’s Sidecar file or Speech Analysis 
(EXCEPT: If you Export>Speech Analysis from the Sequence then any changes you’ve made 
WILL get saved to SA)

We know this is a little confusing, but just think of it as the difference between the Source 
panel and the Timeline panel. When in Clip Mode, it’s like using the Source panel. Everything 
you do there affects ONLY the clip.

Sequence Mode is, well, like using a sequence timeline. You can cut the clip, apply effects, 
etc. and none of that affects the actual media file. In this case, the transcript only relates 
to that sequence. Changes you make to the sequence transcript are only stored with the 
sequence.

Uh… What did you just say?

The most important transcript is in the sidecar file next to the media file (e.g. MyMovie.mp4, 
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MyMovie_transcript.json). When you make edits in Clip Mode, they get saved here. The 
sidecar file saves not only text but formatting as well. If you move the media, make sure the 
sidecar goes with it. Export>Speech Analysis if you want to save it into the Clip’s metadata 
which will usually save it to the MyMovie.mp4 file. However, this won’t retain formatting, just 
the text.

Sequence Mode: Editing a transcript for a sequence doesn’t affect the sidecar file. So it won’t 
permanently change the Clip’s transcript.  

Editing Text

The Transcriptive 2.0 Text Editor now behaves like a word processor. You just place your 
cursor where you want to start typing and... start typing. You can also double click to select 
an entire word. Since every word has timecode, it doesn’t behave _exactly_ like MS Word or 
something. There are differences. So please read the section on the Text Editor. You definitely 
want to understand how to edit the text without losing the timecode associated with each 
word.

This is VERY different from how Transcriptive 1.0 worked. You no longer need to press ‘Enter’ 
to start editing text. ‘Enter’ will now create a new line, just as it does in a regular word 
processor.

As with the previous version, there are a lot of keyboard shortcuts to help you edit faster. 
Some of these have changed from 1.0. Please take a look at the section on Keyboard 
Shortcuts to familiarize yourself with what you can do. See Page XXX for more info

Selecting Video/Audio to Transcribe

Transcribing A Clip

You can now transcribe individual clips. Just select the clip you want to transcribe in the 
Project panel and click Transcribe. (Make sure you’re in Clip Mode)

Transcribing A Sequence

First off, make sure the Clip Mode switch is turned off and you’re in Sequence Mode.

If you’re transcribing a sequence, Transcriptive will transcribe whatever audio is in the active 
sequence you have selected (we’ll cover Batch processing in a moment). So if you’re looking 
at the timeline of MySequence, that will be the audio that gets transcribed. ALL the audio. So 
if you have multiple tracks of audio it’ll send all of it to the Speech Services. 

This is great if you have dialog on a couple tracks. Both tracks will get transcribed. However 
if you have dialog on one track, music on another track, goats braying on another track, etc., 
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etc…. that’s not so great. Mute the music and the goats before transcribing your dialog. You’ll 
get much better results.

In/Out Points 

Transcriptive will honor IN and OUT points when transcribing sequences (but not with clips... 
however, you can set in/out points in Clip Mode. See Editing with Text on page 25). So if 
you want your entire transcript transcribed or just a portion of it, make sure the ‘Sequence 
Length’ matches what you’re expecting. If it says ‘5 minutes’ and your sequence is 30 
minutes, there’s a problem. It might be the IN/OUT points.

Batch Processing

There are multiple ways of batch processing. Let’s discuss.

Ultimately they all do the same thing: process multiple clips and put the entire transcript into 
the Speech Analysis section of Premiere’s Metadata panel for each clip. This means you can 
search the metadata of each clip in the Source window to find any text in the clip you are 
looking for. If you drop the clip into a sequence, Transcriptive will use the metadata to build 
the transcript, so you don’t incur additional charges from the speech services. It’s very cool if 
you have a bunch of clips you want transcribed.

When you batch process, Adobe Media Encoder gets launched so Premiere doesn’t get tied 
up while all the clips get transcribed. If you have a lot of clips that could take a while and we 
didn’t want Premiere to become unusable while waiting for the transcripts to get back.

Batch Files

This will bring up a dialog letting you select multiple files to be transcribed. This is more or less 
the same as any Open dialog you’ll see.

Batch Folder 

This will bring up a dialog letting you select a folder. Every video/audio file in that folder will 
be transcribed.

Batch Project 

If you have all the files you want transcribed imported into Premiere, create a bin named 
‘Transcriptive’(with a capital “T”). Place all the files you want transcribed into that bin. 
When you select Batch Project, Transcriptive will take all the files in that bin and transcribe 
them. Once that is done, you can move the clips out of the Transcriptive bin. There are some 
Premiere limitations that prevent us from just allowing you to randomly select files in your 
project. So this was the best workaround we could come up with, but we realize it’s not ideal.

Once you’ve selected your files, you’ll see the Transcribe dialog box. See Page_ for more
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Clip Based Workflow : Editing with Text

If you have a clip based workflow, where you drag selects from the Source panel into a 
sequence, this is for you!

It opens up an ‘Editing Video with Text’ workflow. Where you can search for where dialog 
was spoken, select the text and use that to create an edit.

Make sure the Clip Mode button is turned on. (see Clip Mode vs. Sequence Mode below for 
more info on the difference when this is on or off.)

When this is turned on, you can select video or audio files in the Project Panel. If they have 
a transcript that will appear in Transcriptive, if not, you’ll be given the option to Import or 
Transcribe.

When the transcript for the clip appears in the Transcriptive panel, the clip should also appear 
in the Source panel. At this point you can edit and search the transcript as you would expect. 
However, you can also set IN and OUT points (Control + i and Control + o) and INSERT 
(Control + comma) the segment between the IN/OUT points into the active sequence.

This allows you to search the text of the transcript, find the segment you want and then quickly 
insert it into the timeline of your edit. 

Check out our video tutorial on this feature at: https://youtu.be/KVUt2IOR4-c
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Transcriptive User Interface

The user interface is divided into five sections:

1- Top bar with the Menu, Transcribe button, and Status field

2- The main text area for editing the transcription

3- Speaker Identification column showing speakers (this only shows if there speakers were 
identified)

4- Timecode column

5- Bottom bar with the Export options

The Top Navigation Bar

The top bar in the UI has many critical functions. The Main Menu has all the setup dialogs, 
Speaker, Transcript Deletion and Batch Processing dialogs. The lower portion of the bar has 
Undo/Redo buttons, Delete, Split/Merge and punctuation buttons.
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Top Nav> Main Menu

Main>Speech Engine Setup

This dialog is no longer as important as it used to be.

For Transcriptive A.I. and Speechmatics, all you need to do is log into your Transcriptive.com 
account. Nothing else is needed. You can do this in this dialog or under the Account menu.

For Speechmatics, this is only relevent if you’re using their On-Premise solution. You can enter 
in your credential information by going to the Speechmatics tab in Speech Engine Setup. 

On January 1st, 2020 this will stop working with Speechmatics.com accounts.

If you want to set up Speechmatics on your own in-house server, please contact  
sales@digitalanarchy.com for more information on their On-Premise solution.

Main> Speaker Managment

You can add, change or delete the names of the speakers in your transcript using Speaker 
Management. This is useful for when exporting paper transcripts, or grouping your transcript 
by speaker. By default the Speech Services return ‘Speaker 1’, ‘Speaker 2’, ‘Speaker 3’, 
etc. You can also add/delete speakers here as well. Speaker Identification is probably the 
weakest part of the A.I. services, so expect to use this dialog a lot.

Change Only One Speaker Line checkbox

With this selected, when you change a speaker in the main UI, it only changes that one line 
or transcript.

Main Menu: This is your control panel of 
sorts. Speech Engine Setup and Preferences 
are located here. You can Batch Process files 
using the three options. You can also manage 
transcripts here.
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If this is NOT selected, then multiple lines will be changed. All lines below the one you 
change will also change until Transcriptive encounters a line with a different speaker. This can 
be convenient if there’s a lot of dialog and one or the other person speaking for a significant 
time. It works like this:

Original								        Changed 
1: Speaker 1		  On Line 2, the A.I. gets it wrong.		  1: Speaker 1 
2: Speaker 1		  -------- Change to Speaker 2 ----->		  2: Speaker 2 
3: Speaker 1		  Speaker 2 is actually speaking and		  3: Speaker 2 
4: Speaker 1		  continues until Speaker 3 speaks.		  4: Speaker 2 
5: Speaker 3		  Changing Line 2 will cause 3 & 4 to		  5: Speaker 3 
6: Speaker 3		  also change and stop at Line 5.		  6: Speaker 3 

Main>Deleting Speakers

One interesting use of this is that if you decided you don’t want to worry about speakers, 
you can delete all the names in this and it’ll remove the Speaker column in the Transcriptive 
panel.

Main> Sync Transcript to Sequence Edit

This is sort of shortcut to Import>Speech Analysis and only works when you’re in Sequence 
Mode. This looks at the edits in your timeline and regenerates the transcript based on the clip 
segments that are there.

When you initially create a sequence, you might just drop the entire clips into it and then edit 
it down. So when the transcript is initially created it’ll include the entire transcript for all the 
clips. Once you edit the sequence, deleting parts of the clips you don’t want, the original 
transcript will not represent what’s on the timeline. 
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This syncs the transcript to what’s actually on your timeline.

*NOTE: This will overwrite any changes you’ve made to the sequence transcript. When 
recreating the transcript it does so from scratch. Meaning it’ll pull from the transcripts saved 
in the clip’s metadata. So if you plan to do this, don’t edit the sequence’s transcript. Switch to 
clip mode and edit the clip’s transcript.

Main>Delete Transcript

This simply clears out whatever text  is in the Editing Window. You don’t _need_ to do this. If 
you click the Transcribe button it’ll overwrite whatever is in the Edit Window. However, it can 
be useful to visually see that you’re creating a new transcript. So if you want a blank page 
before getting a transcript, just select New Transcripts.

Main>Delete Speech Analysis

Speech Analysis is where Premiere saves the transcript into a clip’s metadata. Transcriptive 
is very good about keeping transcripts saved in a clip’s metadata. USUALLY people do 
not want to lose the transcript and have to pay for transcribing something they already 
transcribed.

However, there may be times when you want to wipe out the transcript completely. You might 
need to send the movie file to someone and not want the transcript included. In that case 
you’d want to delete anything stored in Speech Analysis metadata. This option will do that.

Main> Upgrade Project

This is primarily for Transcriptive 1.2 and earlier users. With version 1.5 we made some 
significant changes to the way we store data. So if you have a very old project, you may 
need to run Upgrade Project to convert those projects to the new format.

If you started using Transcriptive with 1.5 or 2.0, you can ignore this.

Main> Batch Processing

There are multiple ways of batch processing. Let’s discuss.

Ultimately they all do the same thing: process multiple clips and put the entire transcript into 
the Speech Analysis section of Premiere’s Metadata panel for each clip. This means you can 
search the metadata of each clip in the Source window to find any text in the clip you are 
looking for. If you drop the clip into a sequence, Transcriptive will use the metadata to build 
the transcript, so you don’t incur additional charges from the speech services. It’s very cool if 
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you have a bunch of clips you want transcribed.

When you batch process, Adobe Media Encoder gets launched so Premiere doesn’t get tied 
up while all the clips get transcribed. If you have a lot of clips that could take a while and we 
didn’t want Premiere to become unusable while waiting for the transcripts to get back.

Batch Files

This will bring up a dialog letting you select multiple files to be transcribed. This is more or less 
the same as any Open dialog you’ll see.

Batch Folder 

This will bring up a dialog letting you select a folder. Every video/audio file in that folder will 
be transcribed.

Batch Project 

If you have all the files you want transcribed imported into Premiere, create a bin named 
‘Transcriptive’. Place all the files you want transcribed into that bin. When you select Batch 
Project, Transcriptive will take all the files in that bin and transcribe them. Once that is done, 
you can move the clips out of the Transcriptive bin.

Once you’ve selected your files, you’ll see the Transcribe dialog. See below for more details 
on that.

Main> Preferences and Jobs

These can be accessed by icons on the top navigation bar, so they are discussed in a few 
pages.

Main> Help

The Help section will provide you with links to Keyboard Shortcuts, Video Tutorials, FAQ, this 
Manual, and all around general Tips and Tricks. You can always reach us at  
cs@digitalanarchy.com or 1-415-287-6069

Main> About

Last but not least the Main Menu contains the About section. Here the only lots of information 
about the version of Transcriptive you’re running, whether it’s up to date or not, and of course 
our support cats and Callie The Pitmix who’s our Director of IT.
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Top Nav> Import Button

This is a pretty important dialog and lets you get transcripts into Premiere in a number of 
ways. Use the Import Transcript dialgue to import a variety of file types as well as retrieving 
transcripts from Speechmatics, Transcriptive-A.I. and Speech Analysis. 

 
The Import dialogs for Plain Text, SRT, and Transcriptive

Some of the common fields in the Import dialogs:

Character Encoding: Text files are encoded in certain ways depending on the text in them. 
For example, Asian languages need 16-bit text files vs. 8-bit usually required for Western 
languages. If you leave this set to ‘Auto-Detect’ it should work fine. If not, you can manually 
select the encoding.

Timing Per Word: If this is selected, Transcriptive will attempt to give every word timecode. 
It greatly helps if the file has timestamps. We interpolate between timestamps (i.e. make 
educated guesses) to get timecode for the words. So if some says ‘The quick brown fox’ 
between the 10 second mark and the 14 second mark, it’ll go something like this:

10:00: The 
11:00: quick 
12:00: brown 
13:00: fox 
 
The time range (4 seconds) is divided by the number of words and each word is then 
assigned a timecode. This means if you have VERY frequent timestamps, like an SRT, the 
guesses can be pretty accurate. As you can imagine, if there are no timestamps then the 
guesses are likely to be wildly off.

With SRTs and other subtitle/caption formats we know there will be timestamps. With Plain 
Text files we don’t know for sure, so there are other options which will allow you to give us 
some guidance as to the format of the timestamps and if they’re there at all. Usually we can 
auto-detect it but sometimes you need to tell us what to expect.
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Ignore Speakers: If the text file has speakers listed, you can choose to ignore them and 
ONLY bring in the dialog.

Speakers Field: This will show you which speakers we have identified. You can tell us to 
ignore one or all of them.

Starting Timecode: You can let us know what the starting timecode should be for the file. 
This assumes that the text file starts at 15:10:00 and you want to tell us the video clip starts at 
15:00:00.

Set Start Time: This assumes that the timecode in the text file is different than the Starting 
Timecode you entered above (perhaps the file starts at 00:00:00). In which case 
Transcriptive will ignore the start time in the file and conform all the timecode to what you 
want it to start with.

Import> Plain Text 

This imports any plain text file into the Transcriptive window. The text will usually come in 
without timecode, so it’s going to be of limited use unless you use Alignment to sync up the 
text and audio. However, if the text file has timestamps and you turn on ‘Timecode per word’, 
Transcriptive will attempt to give each word timecode.

Other than the words next to the timestamps this is pretty inaccurate as it interpolates between 
the timestamps and guesses. Although, if you have _very_ frequent timestamps, as you do 
with SRT files, it can be reasonably accurate.

Existing Text File as A Transcript 

If you already have a transcript for a video file and want to sync that up to the audio of the 
video, you can use the Plain Text importer to do that. Import the plain text file and then click 
on Transcribe. Select Alignment from the ‘Transcribe With’ dropdown. This will sync up the 
timecode of the spoken words with the plain text file. See the section on Alignment for more 
info.

Import> SRT (Frequently better than plain text for Timing Per Word)

If you have an existing transcript as a SRT file, you can use the SRT Importer to get that into 
Transcriptive. Since SRTs only have timecode for whole lines, the individual words do not have 
timecode, unless you have Timing Per Word turned on. You can still search and jump to where 
a sentence was spoken, but you can’t do so for individual words. 

However, when Timing Per Word is on, Transcriptive will use the very frequent SRT 
timestamps. It’s a great way of adding timecode per word to text that doesn’t have it.
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If you want to import captions from YouTube or Facebook, use SRT. Here are instructions on 
how to do so: https://digitalanarchy.com/blog/art-technology/downloading-the-captions-
facebook-or-youtube-creates/

One huge advantage of SRT is that the timestamps are very frequent. Usually every few 
seconds. This means Timing Per Word is usually very accurate. 

Combine Lines into Paragraphs: Subtitle lines tend to be short, often just 32 characters. 
You have the option of combining these lines into sentences or paragraphs. If the text has 
periods, you can select ‘Split Lines Based on Punctuation’ and a sentence will be formed 
every time there’s a period. If there isn’t any punctuation then it’ll just create a large 
paragraphs of text.

Import> JSON 

Usually, you don’t need to worry about this. However, JSON is the format of the text file 
Transcriptive uses internally to save transcript data. You can import them directly although 
usually Transcriptive will just read them. But if the file gets moved or something you might 
need to import it manually. JSON files are 1) the format Transcript saves the sidecar file in 
(MyMovie_transcript.json) and 2) created by the Speech Services when they generate the 
transcript. This is what Transcriptive gets when you request a transcript. It’s also what gets 
imported when you go to the Jobs section and click Import.

This also lets you get the transcript on one machine and move it to another. So if your 
facility only has a couple machines connected to the internet, you can use them to get the 
transcription, grab the JSON file and move it to the machine without an internet connection. 
Usually this is stored next to your media file (e.g. MyMovie.mp4 and MyMovie_transcript.
json)

Import> Speech Analysis

Importing Speech Analysis will populate your Transcript Window with any transcript that’s in 
the metadata of your clip (Clip Mode) or all clips that are in your active sequence (Sequence 
Mode). This is used to create a new transcript that reflects edits you’ve made to your timeline.

This pulls data from two places: First, a clip’s JSON sidecar file and secondly, if there’s no 
sidecar file, the Speech Analysis section of the Metadata panel. (See the JSON Sidecar vs. 
Speech Analysis section for more info on how this all works)

You can view the transcript that’s in Speech Analysis by opening the Metadata panel in 
Premiere. Towards the bottom you’ll see the Speech Analysis section. If the selected clip has a 
transcript in the metadata you’ll see a block of text there.

https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-or-youtube-creates/
https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-or-youtube-creates/
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Top Nav> Transcribe Button

The heart of transcriptive is the Transcribe button. This is where the magic begins.

Once you’ve selected the sequence you want to transcribe and muted any non-dialog audio 
tracks, you’ll press the TRANSCRIBE button.

This will bring up the Transcribe dialog box. 

Transcribe Dialog Box

Before Transcriptive sends the audio file off to the Speech Services we need to tell you a few 
things and we need to know a few things.

Most importantly, which Speech Service do you want to use, Transcriptive or Speechmatics? 

Please use Transcriptive if accuracy is critical to you. It’s more accurate than 
Speechmatics across a wider range of audio quality.

So you’ll need to select one or the other. If you have not setup the Speech Services, there’s 
a button that will take you to that dialog box. You can’t use transcriptive without setting up at 
least one Speech Service.

What We Tell You

First off, we tell you how long the audio is that you’re transcribing. You should check this to 
make sure that you’re not transcribing 3 hours of video when all you really want is 15 minutes.

We also tell you the sequence or clip name, so you can verify you’ve got the right item 
selected.

Most importanly, we tell you the cost. If for some reason this doesn’t line up with your 
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expectations, STOP and double check everything. If you’re transcribing a 60 minute clip 
(between $4.00-7.00 depending on the service) and it says $1.10 or $20, something is 
wrong. Maybe you set In/Out points and Transcriptive is pulling from that. Maybe there’s 
a bug and we’re using the length of the previous clip you had selected (maybe it’s still 
accidentally selected).

The price here is a courtesy and is not binding. Once the file is encoded and we know exactly 
what has been submitted, any bugs on our end usually resolve themselves. So if this has 
an unexpectedly low price, once we process the file, you’ll be charged the correct price. If 
the price is wrong in the dialog we will not issue any refunds. We’re very upfront about our 
pricing and expect that you know what the cost should be regardless of any bugs displaying 
the cost.

Of course, any overcharges... if you actually got charged $20 for a 60 minute video, please 
contact us at cs@digitalanarchy.com so we can issue you a refund.

Transcribe> Options

Transcribe With...: This is where you select which speech service you want to use or sync an 
existing transcript with Alignment. Alignment lets you sync a text transcript up with a video’s 
audio. Giving timecode to a transcript that doesn’t have it. See the section on Alignment for 
more info.

Transcriptive-A.I. will usually be the most accurate, especially if you consider punctuation 
which Speechmatics currently doesn’t do. We’re constantly testing an array of speech-to-text 
services and will use whichever is currently best based on the settings you choose. The service 
we use may change based on several factors including whether Speaker Identification is 
turned on or what language you choose. This is a pay-as-you-go service, so you just pay for 
the minutes as you use them. So it’s a pretty easy option.

Speechmatics will also give you very good results, particularly on clean audio. It doesn’t do 
punctuation other than periods. It’s less expensive than the Transcriptive option. If you have 
a lot of background noise or accents, Transcriptive-A.I. is probably your best bet. It’s almost 
always going to be the most accurate with that type of audio. Speechmatics is great for clean 
audio but the accuracy falls off more steeply as the audio quality gets worse.

Of course, we strongly suggest you run a few tests on your own video footage with 
varying audio quality to see the results yourself. 
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Languages: 

We support 24 languages currently. This does not mean we support all of them well. For the 
more common languages: English, Spanish, French, Japanese you should expect a very high 
accuracy rate. For less common languages: Catalan, Hungarian, etc. the results may not 
be acceptable. Please run some tests before doing a large transcription project. Select the 
language of your video and away you go. Neither service supports multiple languages in a 
single video.

Speaker Identification

Next, select if you want Speaker Identification and tell us how many speakers there are. 
See the Speaker Identification section for more details on this. Neither speech service does 
a great job of identifying speakers. It’s better than nothing, and the Transcriptive service 
performs better, but it definitely requires clean up. 

Align Current Text checkbox (Paid Alignment)

If you’re getting a new transcript from one of the speech services, make sure this is turned 
off. See the section on Importing An Existing Transcript. This allows you to take an existing 
transcript and sync it to the audio, adding timecode to the existing text. Incredibly useful if you 
already have a transcript from a human transcription service. You MUST import an existing 
text file for this to work. Also, this will incur a cost. If you want to use the free alignment, you 
must choose ‘Alignment’ from the ‘Transcribe With’ dropdown.

When you click OK and Transcriptive exports the audio and sends it to the Speech Services.

Transcriptive-A.I. is $0.02/minute for this service and Speechmatics is $0.04/min. Both 
will produce similar quality results.

Remember: If you use ‘Transcribe With: Alignment’, you can do this for FREE. (English only 
though)
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Top Nav> Auto-Load Toggle

If the Auto-Load button is OFF, it will lock the Transcriptive window to the transcript 
for a particular sequence or clip. Regardless of what the Active Sequence/Clip is, the 
transcript doesn’t change.

If it’s turned ON, then every time you switch to a different sequence or clip, the 
transcript for that sequence/clip is loaded.

This is useful if you’re switching between sequences to find clips or other info 
but you’re only working on one transcript. If this is not turned Off, as you switch 
sequences Transcriptive will load the transcript for that sequence. Usually this is great. 
However, if you’re only working on one transcript, constantly having Transcriptive 
load a different transcript can be annoying. Auto-Load solves that problem.

To use it, go to the sequence/clip you want to always see the transcript for. With 
that sequence/clip selected, turn Auto-Load to OFF. Now whenever you switch to a 
different sequence, you’ll only see the original, locked transcript.

Top Nav> Clip Mode Toggle

Clip Mode is probably the most requested feature. It allows you to edit the transcript 
of individual clips. You no longer have to drop them into a sequence to transcribe or 
edit the transcripts!

In fact, Clip Mode is now where the ‘Master’ transcript for any clip lives. 

What does ‘Master Transcript’ mean? 

The edits you make to the transcript in Clip Mode will get saved to clip’s metadata 
and become permanent. If you drag a clip into a sequence, the sequence transcript 
will be built using the Master Transcript created in Clip Mode. HOWEVER... The 
edits you make to Sequence’s transcript do NOT change what you see in Clip Mode 
and aren’t stored permanently. Those edits won’t appear in the metadata or other 
sequences you drop the clip into. More about this  below in Clip Vs. Sequences and 
JSON Sidecar sections.

Clip Based Workflow : Editing with Text

If you have a clip based workflow, where you drag selects from the Source panel into 
a sequence, this is for you!
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It opens up an ‘Editing Video with Text’ workflow. Where you can search for where dialog 
was spoken, select the text and use that to create an edit.

Make sure the Clip Mode button is turned on. (see Clip Mode vs. Sequence Mode below for 
more info on the difference when this is on or off.)

When this is turned on, you can select video or audio files in the Project Panel. If they have 
a transcript that will appear in Transcriptive, if not, you’ll be given the option to Import or 
Transcribe.

When the transcript for the clip appears in the Transcriptive panel, the clip should also appear 
in the Source panel. At this point you can edit and search the transcript as you would expect. 
However, you can also set IN and OUT points (Control + i and Control + o) and INSERT 
(Control + comma) the segment between the IN/OUT points into the active sequence.

This allows you to search the text of the transcript, find the segment you want and then quickly 
insert it into the timeline of your edit. 

Check out our video tutorial on this feature at: https://youtu.be/KVUt2IOR4-c
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Top Nav> Sharing Menu [t]
This allows you to share the sequence or clip (and transcript) with your Transcriptive.com. You 
can edit the transcript in a browser. Very useful if you’re going to be away from your main 
computer with Premiere on it and you want to edit the transcripts.

Currently this is in beta. Ultimately you’ll be able to share with other Transcriptive.com users. 
However, for the moment, you can only upload to your own account.

To share the sequence or clip, click on the [t] icon and select Create New.

This will open a dialog that will let you name it or associate a billing code with the web 
project.

You can then either upload a thumbnail of the video file, the transcript or both.

Go to Transcriptive.com, log in and you’ll see the new web project with the video and 
transcript (assuming you uploaded both of them).
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Top Nav> Jobs Menu     

If there’s an internet failure of some sort and you don’t receive the transcript OR you just want 
to reload the transcript, this makes it even easier to grab the JSON file. This shows a list of 
all the jobs you’ve submitted to Transcriptive. You can select the one you want to use for the 
sequence you’ve selected. (If you have ‘Delete Transcription Jobs’ set in the Preferences, the 
jobs will not be stored and nothing will show up here)

 

Just click on the Cloud icon to import the transcript from that job. That will load the transcript 
into the Transcriptive panel.

Top Nav> Preferences Button  

This will show the various preferences that you can set in Transcriptive. 

Speech Service Settings

As stated before, Speechmatics/Transcriptive will hold any job of yours for up to 30 days 
on the server before deleting it. You also have the abilitly to control whether you want the 
services to save your trnascripts at all. If you feel safer not having your transcript saved on 
the server, simply check the ‘Delete transcription jobs from server’ box to automatically 
delete your transcript from their server.

You can also turn off Speechmatics email notifications if you like.

Other

Here you can decide whether you want Transcriptive to automatically check for new updates, 
show drop frame timecode, or change the the time between which Transcriptive auto-saves to 
the Premiere project file.
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Under “Other” is where you’ll also find all of the file types that Transcriptive can batch 
transcode to FLAC via Media Encoder.

Display

In the display portion you’ll find the ability to show clip name in your timecode column as a 
quick and easy indicator of what clip you’re at in your sequence. 

This is also where you’ll find the option to turn off the on-boarding tutorial that pops up 
whenever you open the Transcriptive panel.

Proxy Server

In order to return transcripts from the speech services, Transcriptive must have an open 
connection to either Speechmatics or Transcriptive-A.I.. If you’re in an environment that utilises 
a proxy server, you will need be sure to open up a connection.

Here you’ll find two options to work with. “Use System Setting” will search for whichever 
setting your browser uses to connect to your proxy server allowing you to simply use your 
credential as you would for your browser. 

The other option is to use Manual Settings. Here you’d enter the proxy server address along 
with port number to connect Transcriptive.

If this is all foreign information to you, but you know you’re in a proxy server environment, 
have your I.T. person help you out. They’ll know what to do.

Whitelisting for Firewalls

Here are a list of URLs you may need to whitelist for Transcriptve to work:

digitalanarchy.com 
app.transcriptive.com 
api.speechmatics.com             	TCP 443  
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Top Nav> Notifications Menu (Transcription Status) 

The Bell icon in the upper, right corner will tell you the status of your transcription, if it 
succeeds or fails and other important messages

The messages you most commonly will see are:

Encoding FLAC file: This means we’re exporting the audio as a lossless FLAC file, which is 
what the Speech Services require.

Waiting for Transcriptive-A.I.: Once the audio file is sent, we wait for the Speech Services to 
respond either with the transcription text file or an error message. Usually this will take about 
1/4th to 1/2 the time of the audio file. So if you send a 10 minute audio clip, expect it to be 
done in 2-5 minutes.

Transcription Successful: Transcriptive has received the text file and you should see the 
transcription in the Transcriptive panel.

Transcription Failed: This can happen for a number of reasons, including the service being 
down. We try to provide helpful error messages but the Speech Services aren’t always helpful 
in this regard, so sometimes we don’t know why it failed.
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Top Nav> Account Menu

This shows you your options for Transcriptive.com and the Transcriptive Speech Services. You 
need to create an account on Transcriptive.com in order to use the Transcriptive-A.I. as that’s 
where we manage billing.

It allows you to create an account, login, and logout. You can also view the jobs you’ve 
submitted, your dashboard, and account settings.

Account> Login/Register

If you’re not logged in, you’ll see a Login link and a Register link. Use Login to access your 
Transcriptive.com account and Transcriptive-A.I. service. If you don’t have an account, you 
can create a free one by clicking on Register. 

You don’t have to do this to use the Transcriptive panel. If you only want to use Speechmatics, 
you don’t need to create an account on Transcriptive.com. The panel will be fully functional.

However, by creating an account, you can use the Transcriptive Speech Services and you 
can send and receive transcripts from producers or clients using the browser version of 
Transcriptive. Please see Page _ for more info on working with Transcriptive.com

Account> Jobs

This is the same as going to Main Menu>Job Management. It allows you to see all of the 
transcription jobs you’ve placed and reload them if necessary.

Account> My Dashboard

This will take you to your Transcriptive.com dashboard, where you can see how much you’ve 
spent, all your jobs and the costs they incurred, change Billing info and other information 
about your account.

Account> Account Settings

Use this to edit basic account settings like Name and Password. If you want to change your 
Billing information please use My Dashboard instead as it will allow you to change all the 
settings associated with the account.
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Top Nav> Undo/Redo

These buttons allow you to undo or redo the last action. You can also use Control+Z for Undo 
and Control+Shift+Z for Redo. NOTE: On the Mac it is also Control+Z as a panel can’t use 
Command+Z.

Undo/Redo doesn’t work for everything. You can’t undo merging and splitting sentences, for 
example. Eventually we’d like to have everything undoable, but for now it’s just text changes, 
which should over most peoples needs.

Top Nav> Punctuation Bar

These buttons let you easily add punctuation. Just select the word and hit the button or 
corresponding keyboard shortcut (the punctuation key on the keyboard, for example to add 
quotes, select the word and press the Quote (“) key). This makes it very easy to add basic 
punctuation.

The great thing about this is you don’t have to place the cursor exactly where you want the 
punctuation. With Transcriptive, as you’re playing back the audio, you can stop the highlight 
on the word you want to add quotes to and press the “ key, then press Control+” and you’re 
done! Two keystrokes vs. six keystrokes.

On the far right of the Punctuation bar you have four more buttons. From left to right they are: 
Delete Word. Delete Punctuation, Split Line, and Merge Line. Split/Merge Line makes it easy 
for you to separate speakers from when the Speech Service incorrectly assignes the wrong 
speaker, or you’d like to separate a sentence for captioning spacing.
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Transcript Window

As you might guess, this is where your tanscript will visually live as you work with 
Transcriptive. In the Transcript Window you can edit the transcription. It also highlights the text 
as the video plays, allowing you to easily follow the text as you listen to the audio playback.

You can edit with keyboard shortcuts as the video plays or you can go into ‘word processor’ 
mode by pressing Enter and edit as you usually would with a text editor.

We cover all this in more detail in the Text Editing section on Pgs 50-54. Also check out the 
Keyboard Shortcuts section.

Transcript Window> Speaker Identification Column

If you selected ‘Speaker identification’ when you transcribed, the Speech Services will 
attempt to identify how many speakers you have and which text is attributable to each one. 
Neither Speechmatics or Transcriptive are awesome at this, and this typically needs a fair 
amount of cleanup. Transcriptive-A.I. will usually do a better job however.

The Speaker Column shows which speaker the Speech Service thinks said that particular 
sentence.

You can change the speaker by clicking on the dropdown menu and selecting the correct 
speaker. You have two options for how it behaves when you do this. You can change one line 
at a time OR you can have it change every line below that until it runs into a different speaker. 
You can change that by going to the Speaker Management dialog in the main menu. 
Here’s how the multiple line mode works:

Original								        Changed 
1: Speaker 1		  On Line 2, the A.I. gets it wrong.		  1: Speaker 1 
2: Speaker 1		  -------- Change to Speaker 2 ----->		  2: Speaker 2 
3: Speaker 1		  Speaker 2 is actually speaking and		  3: Speaker 2 
4: Speaker 1		  continues until Speaker 3 speaks.		  4: Speaker 2 
5: Speaker 3		  Changing Line 2 will cause 3 & 4 to		  5: Speaker 3 
6: Speaker 3		  also change and stop at Line 5.		  6: Speaker 3
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By default the column will show Speaker 1, Speaker 2, etc. You can change that to real 
names by going to the Speaker Management dialog in the main menu. You can also add 
speakers there.

Transcript Window> Timecode Column

This shows the start  timecode of any given sentence or block of text. In most cases, each 
word will have timecode associated with it. As you click on each word, the Time Marker in 
Premiere will jump to the portion of the timeline where it’s spoken. The Timecode Column only 
displays the timecode for the first word.

If you split (Opt/Alt+Down Arrow) a sentence or block of text, the timecode of the word you 
split on will appear in the Timecode column.

Another piece of information you can find in the Timecode column is when a new clip has 
started in your timeline. If you see the name of a clip in the timeline column, you know that 
every timecode appearing below is in that specific clip until you see the next clip name.

This column is primarily for informational purposes only.  

However... you can now adjust timecode for every word. Just right+click on any word to get 
the Adjust Timecode dialog. If you adjust the first word in a sentence or create a new line with 
a word you’ve adjusted, the Timecode Column will update accordingly.
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Bottom Navigation Bar

The lower navigation bar has controls to move around the text, Search toolbar and the Export 
dialog. All critical parts of Transcriptive.

Playback And Cursor Controls

The controls right below the text window allow you to move where the highlight is. Especially 
when you’re using the keyboard shortcuts, it’s fast and easy to highlight any word. The 
controls are:

	 - to the next/previous word (keyboard shortcut: right/left arrow)

	 - to the next/prev sentences (keyboard shortcut: Alt/Opt + right/left arrow)

	 - to the next/prev speaker (keyboard shortcut: Alt/Opt + Shift + right/left arrow)

	 - Play: Starts playback. The video/audio will play while the highlighted word moves 		
	 along with whatever is spoken. (keyboard shortcut: Spacebar)

	 - Playback Speed: Lets you set the playback speed to realtime or 1.5x faster than 		
	 realtime. This is very useful, especially if the transcript is accurate. You can 			 
scan for incorrect words much faster. It takes a little getting used to, but once 			 
you do it’ll speed up your cleanup.

Sync to Playhead (recycle icon): This jumps the highlighted word in the Transcriptive panel 
to match where the time marker is in your sequence or clip. If you move the Time Marker, 
Transcriptive doesn’t know about it, as Premiere’s timeline doesn’t notify Transcriptive about 
the change. If you click on this icon, this will sync the highlighted word to where the Time 
Marker is. 



48 © 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: User Interface
 Transforming Transcripts, Search & Editing

Export

There’s a lot going on in this little dialog. You can export the entire transcript to a closed 
caption file, export it to Premiere’s metadata or markers, or export a plain text file for paper 
edits.

 

Export> Plain Text/Rich Text Format

Exporting paper trancripts can be done easily with Transcriptive. You have the option of 
both Plain Text (.txt) and Rich Text Format (.rtf) file types. RTF has more formatting options 
than Plain Text, and is recommended when exporting transcripts meant to be looked at by a 
human. Plain text works better if you’re going to be importing the file into another system. A 
Caption Editor for example. Both file types can be opened in various word processors.
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Export> JSON

These files are mostly for moving the transcript to a different machine with Transcriptive or 
backing up the edited transcript. You can just move the entire Premiere project to the other 
machine. However if you just want to get the transcription over to the other machine, you can 
export out as JSON file and import it on the other end. See pg 22 for more information on 
moving transcript and project files. 

While these are technically text files, there’s no standard JSON format, so it’s unlikely other 
applications will import the JSON saved from Transcriptive.

Export> Sequence Markers

This exports the transcript to sequence markers. You can then search the text via the Markers 
panel. This can be very useful if you want to close the Transcriptive panel or if you need 
to send the project to someone that doesn’t own Transcriptive. The entire transcript will be 
embedded into sequence markers which will show up in both the timeline and Program 
window.

When you export you get three options:

Set Duration: The Markers will have a start and end time. Regular markers can be hard to 
grab, but with this set, the marker will stretch over the time the words are spoken. The larger 
markers also make it easier to hover over to see the text that’s in them.

Include Speakers: This will include the speaker names in the text of the markers.

Seconds Between Markers: This sets the frequency of the markers. If you set this to 10 
seconds, a marker will be laid down about every 10 seconds. Each marker will include 
the text that STARTED being spoken in the10 seconds after the marker (to use the above 
example). So if you have a sentence that starts at 10:05, another one at 17:15 and a third at 
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19:20, those three sentences will be included in the marker at 10:00.

But, you know... it’s complicated.

If the sentence that starts at 19:20 is long and the next sentence is at 31:10, no marker will be 
laid down at 20:00 as no sentence starts between 20:00 and 30:00. The next marker will be 
at 30:00.

Export> Clip Markers

Clip Markers can be an awesome way of moving the transcript around. Clip Markers are 
embedded into the video file, so if you import the clip into a different project or move it to a 
different machine, the clip markers (and the transcript) will go with it.

You’ll see these show up ON the clip itself in the timeline. Sequence markers show above the 
timeline.

The options are the same as Sequence Markers (see previous poge) and work the 
same way.

Export> Speech Analysis

Exporting to Speech Analysis overwrites the metadata of the clips in your timeline. This will 
save the data to the clip’s sidecar file as well as the XMP Speech Analysis field. (see JSON 
Sidecars vs Speech Analysis section) 

When you first transcribe a clip, the original un-edited version gets saved in the Speech 
Analysis field. Export>Speech Analysis assumes you want to overwrite this with an updated/
edited version of the transcript. So be careful!

If you highlight a clip in your timeline and then switch to your metadata panel you’ll see the 
corresponding transcript in the Speech Analsysis field.

Having your transcript baked into your clips metadata allows for Transcriptive to conform 
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new transcripts based off your sequence edits.

This behaves a little differently in Clip and Sequence Mode. In Clip Mode Transcriptive is 
always saving to the JSON sidecar file. That’s the ‘Master Transcript’. The original un-edited 
transcript gets saved to Speech Analysis XMP data when you get first transcribe the clip. The 
only way to update Speech Analysis in Clip Mode is to Export>SA.

We don’t generally recommend using this in Sequence Mode. It saves any changes you’ve 
made to a transcript to the relevent clips Sidecar file and Speech Analysis. However, it’s 
possible to lose data if you’ve deleted lines in the Sequence transcript. We recommend you 
edit the transcripts in Clip Mode. 

Export> Closed Captions & Subtitles

Transcriptive can export a variety of closed caption and subtitle files. Each file type has 
different restrictions, but overall they do basicaly the same thing. Be sure to inquire about your 
final delievery to properly choose which caption file is best suited for you.

In Transcriptive when you export a caption file you’ll be presented with a dialogue box with 
options pertaining to your specific file type.

Character Encoding: This allows you to choose which encoding your text will show as. It’s 
important to be correct on this otherwise important diacritical marks may come out differently, 
or as complete nonsense/gibberish.

Captions Standard: You can specify whether the captions meet the 608 or 708 standard. 
Or whether they’re Teletext or Open Captions. Different file formats have different standards.

Caption Type: Let’s you set how many lines you want and how those lines behave... either 
pop-up (one caption is replaced by another) or roll-on (the captions scroll up).

Export> Types of Caption Files

SRT: The SubRip file format is common for online video. It’s also a very basic file that can 
easily be read and edited in programs like Notepad, Wordpad, TextEdit, etc.

VTT: WebVTT  is a caption file for the internet and is a favored file format for YouTube and 
Vimeo.

SMPTE-TT: Closed Caption file that suports 608, 708, Open captions, and Teletext. This file 
is exported as a .XML.

SCC: stands for “Scenarist Closed Caption”, a file type developed by Sonic. SCC file is 
closed caption file for standard definition broadcacting. 608 only.
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MCC: is a MaCCaption closed captioning file, and like SMPTE-TT supports both 608 and 
708 (SD and HD) closed captioning.

EBU-STL: This caption file is the standard for Eurapean Broadcasting with Teletext and Open 
Captions.

SMI: A computer based caption file applicable with many online platforms.

Save Button

As you may have guessed the Save button saves the changes you’ve made to your transcript 
to the Premiere project file. If the button is a shade darker than the Export button next to it, that 
means there’s nothing to update and save. If your transcript has saved successfully, the top 
right Progress bar will tell you, “Save transcript successful”.

Transcriptive will auto-save any changes you’ve made after 10 seconds of idleness. This 
increment can be changed in Preferences found in the drop down Main Menu.
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Search

You can search the transcript to find where a word or phrase is spoken. This only works for the 
clip or sequence that’s currently selected. Transcriptive will search the entire transcript, telling 
you how many instances of the word or phrase has been found and letting you move through 
the results. Of course, when you click on a word, it jumps the time marker to that point in the 
timeline. That works great for a single clip... but what if you have 50 or 100 clips? 
 
If you want to search all your transcripts, metadata, and markers, you can use our 
PowerSearch panel. PowerSearch is a search engine for Premiere. It will let you scour your 
entire project and works incredibly well for projects where all the clips have been transcribed. 
More info is here:  
https://digitalanarchy.com/premiere-search/powersearch.html

* PowerSearch is now bundled with Transcriptive 2.0 for free! *

You should have received a PowerSearch serial number when you purchased Transcriptive 
2.0. If you did not, please contact cs@digitalanarchy.com.

Search> Searching in the Transcriptive Panel

The search field allows you to search for words and phrases throughout the transcript of your 
active sequence. 

https://digitalanarchy.com/premiere-search/powersearch.html
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IMPORTANT: Using quotation marks around a single word will return that specific word and 
not other words that may contain that string of letters. For example putting quotation marks 
around the word “the” will only return “the” and not theater.

When using the search function, the number of results will be indicated on the right side of the 
search field along with the result your playhead is at (signaled by the red-dotted outline). You 
can cycle through your results by using the arrow buttons to the right of the search field or by 
using Tab and Shift+Tab.

 

Search> Find and Replace

Automatic Speech Recognition software is still very much in its infancy, and because of that 
we can pretty much guarantee that there will be mistakes in the transcription, and sometimes 
that mistake will repeat throughout your entire three hour interview. And that makes for a very 
tedious task of correcting.

Find and Replace allows for the quick and easy correction of repeat offenders. If you notice 
that your automated transcript is repeating the same incorrect word you can fix the issue in 
one easy step.

First enter the offending word into the Find field, and then add the correct word in the Replace 
field.

You’ll then have the ability to Replace All instances of the word, or selectively change 
individual instances with the UI buttons found between the two text fields.
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Text Edit Window

Probably the most obvious change from 1.0 is the Text Editor! 

The new Text Editor works much more like a word processor.  So the biggest change is that 
you can just click on a word, place the cursor there and start typing! 

This should be much more intuitive to most users.

One of the biggest complaints we received for TS 1.0 was the way you edited text. It was 
designed for people that edit transcripts all the time and if you to know the keyboard shortcuts 
you could edit transcripts very quickly. However, most editors were not editing transcripts all 
the time, so most users found the text editor frustrating. 

(We do plan on making the old Text Editor an option in an upcoming dot release (2.0.1), but 
it’s a bit of work to make both old and new editor work together)

How The Text Editor Works

You no longer have to press <Enter> to edit the text. Just place the cursor where you want to 
start typing and type away! (or delete away as the case may be) 

You can also double click a word to select it. That’s probably the easiest thing to do if you 
want to replace the whole word.

You use Control + Spacebar to start and stop playback. If you just hit the spacebar by itself 
it’ll insert a space.

Every word still has timecode associated with it, so in that regard it’s the same as the old 
editor (you can also edit that timecode, which is new). This is important if you want to replace 
multiple words. If you just start typing, every word will have the same timecode. You need 
to select each word individually and replace it for the new word to keep the old word’s 
timecode. (Even if the word is wrong, the timecode usually is accurate.)
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Editing Words And Keeping The Timecode

The easiest way of changing an entire sentence and keep all the timecode is to select the first 
word in the sentences, type a new word to replace it, use Option + Forward Arrow to select 
the next word, replace that word, Option + Forward to the next word, replace it, Option + 
Forward, Replace, etc., etc. until you’ve changed the entire sentence.

The above concept is important to understand. If you just went ahead and typed ‘make 
cooked tomato’ the timecode for each word would be wrong.

However, if you replace each word individually, the timecode for each word is retained. 
Again, even if the word is wrong, the timecode usually is accurate.

Adding Missing Words

If you’ve found that the speech service has outright missed a word in your footage/audio, 
or the speaker mumbles two words together, you can add the missing word to the transcript. 
However, because the speech service was unable to identify it properly, the added word will 
not have a unique timecode. We do try and ‘fake’ the timecode by using the words around 
the added text, but that’s just an approximation. You can Right + Click on the word to adjust 
its timecode. That will bring up the Adjust Timecode dialog.

Just type the word next to the most convenient word and Transcriptive will add the word and 
guess the timecode.  You can then Right + Click to make any adjustments.

Playback Speed Button

To speed up the editing process, you can set the Playback Speed to 1.5x or 2x (That’s the 
button on the Bottom Bar in the lower, right corner). It’s surprisingly easy to listen to a video 
that’s been sped up by 150% or 200%. It takes a little getting used to, but once you do, you 
can fly through the editing process especially if the transcript is very accurate to begin with.

The less accurate the transcript, the less useful this becomes. You’ll find yourself having to 
constantly stop and backtrack if it’s very inaccurate. But for accurate transcripts it can be a 
huge time saver. 
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Delete Line

This isn’t a keyboard shortcut, but it’s a shortcut nontheless and is a great way to rid your 
transcript of large unneeded portions. 

Hovering the mouse over the undesired text will uncover an “X” UI button on the far right of 
the Transcript window. Select that button to delete the whole line or paragraph from your 
transcript.

At this time Delete Line is most useful for cleaning up a transcript wherein your goal is to 
export a paper transcript with only a specific speaker and say, not the off camera interviewer. 
It’s best to use this after you’ve exported your transcript to Speech Analysis, this way you can 
always bring it back in the future by Importing from Speech Analysis.

Keyboard Shortcut Changes

You no longer need to press <Enter> to edit text. Just place the cursor and type! <Enter> will 
now split the line just as it would in a normal word processor.

Starting Playback: Control + Spacebar - Just as in a word processor, the Spacebar inserts 
a space between characters, so it’s no longer used to start/stop playback. Use Control + 
Spacebar instead.

Stopping Playback: Control + Spacebar

Merging / Splitting Lines: You can still use Command + Up/Down Arrow. However, <Enter> 
now works for splitting lines. And DELETE will merge lines if the cursor is at the beginning of 
the sentence, again, just like a normal text editor.
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Here are the keyboard shortcuts:

Ctrl + Space - Play / Stop 

Ctrl + Left - Previous Word			   |	 Ctrl + Right - Next Word

Ctrl + Shift + Up OR [Delete]: Merge Line	 |	 Ctrl + Shift + Down OR [Enter}: Split 
Line 

Arrow Key Up: Previous Sentence    		  |	 Arrow Key Down: Next Sentence

Ctrl + Up: Previous Speaker			   |	 Ctrl + Down: Next Speaker

Ctrl + Backspace: Delete Word		  |	 Ctrl + Delete: Delete Word

Ctrl + Shift + Backspace: Delete Punctuations

Ctrl + Z: Undo					     |	 Ctrl + Shift + Z: Redo

MAC USERS: Undo is Control + Z. (Premiere sees Command + Z as Undo for it’s functions)

Punctuation Shortcuts:

Period:			  .		  Left Single Quote:	 ‘			 
Comma:		  ,		  Right Single Quote:	 Command/CTRL + ‘ 
Question Mark: 	 ?		  Left Double Quote:	 Shift + “ 
Exclamation Point:	 !		  Right Double Quote:	 Cmd/CTRL + Shift + “ 
Colon:			   :		  Semi-Colon:		  ; 
Left Parenthesis:	 (		  Right Parenthesis:	 )

Delete Word: Backspace/Delete	 Delete Punctuation: Cmd/CTRL+Backspace
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Working with Closed Captions 
For more info about exporting Caption or Subtitle files, please see Page 51.

Transcriptive can export a varitey of caption files. Premiere unfortunately won’t allow 
Transcriptive to automatically import those files into Premiere. Once you’ve exported 
a caption file, you’ll need to import it into your project manually as if it’s like any other 
media. In your project you can then drag and drop the caption file onto a video track in the 
corresponding sequence.

If you drag a closed caption file into a sequence but nothing pops up in your program 
monitor, you’ll need to alter your program panel settings to look for your specific caption file 
parameters, e.g. 608, 708, open captions (or you’ll need to enable captions if you haven’t 
already). Do this by selecting the wrench icon in the bottom right of the program panel.

Once you can see your caption, highlight the file and open your Captions Panel. Here you’ll 
be able to make more nuanced changes than you can with your initial Transcriptive export. 
For quick formatting changes be sure to Right/Control+click to Select All captions.

 
You can also import these files into applications that are dedicated to adjusting captions. 
Aegisub from http://www.aegisub.org/ is a good, free closed caption editor. 
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Alignment: Syncing Existing Transcripts/Scripts with Audio

One of the most important things Transcriptive can do is take your existing transcript and sync 
it up with the speech in your video. This will add timecode to every word in the text file. If 
Transcriptive can’t read your timecode format, or you’d like to have an even more accurate 
transcript, this is a great option.

Importing A Text File 
For more information about importing Text Files, please see Page 32.

Under the Main Menu is the Import Transcript command. Select that and choose the file type 
of your transcript. In most cases it’ll be a plain text file but SRT is also a good option. See the 
Import section for more details on each of those.

Free Alignment

For English, Transcriptive can now do this offline and it’s free! Once you import the 
text file, go to Transcribe>Transcribe With...>Alignment

This will encode your audio and both the text and audio will be analyzed. The result will be 
that the text you imported without timecode, now has it. Which means you can search, use 
Clip Mode and do all the cool things you can do with the A.I. generated text.
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Paid Alignment

Once the text is in the Transcriptive panel, you need to align it with your video’s audio. To do 
this:

- Click the Transcribe button

- Select Transcriptive-A.I. (You can also select Speechmatics but it’s a bit more expensive. 

- Check the Align Text button at the bottom of the Transcribe dialog

- Click OK

Transcriptive will then encode your media files and send them to Transcriptive-A.I. or 
Speechmatics. The Speech Service will then match the wriiten word of the transcript to your 
audio. Alignment costs less than transcription ($.02/min for Transcriptive-A.I. or $.04/min 
for Speechmatics) and will attached unique timecode to every word. Please be aware that 
we’ve found that alignment often takes longer than transcription. Both services do this equally 
well, so choose whichever is cheapest.

** For very poor audio or audio with a lot of dead air, Alignment may not work.

It does not have to be as good of quality as you’d need for normal A.I. based transcription. 
Alignment is much more forgiving than using A.I. to transcribe from scratch. However, you still 
need to be able to hear what’s spoken.

A lot of long gaps between dialog (dead air) will also cause problems for the Alignment 
service. Sometimes it works fine but it often causes incorrect timecodes.
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Troubleshooting section 

How to Get The Best Results from Transcriptive

Speechmatics will give you the most accurate transcription. So if you’re doing captions and subtitles 
and will be cleaning up the text, Speechmatics will save you a lot of time.

If you’re just using the transcript to allow you to search your video, Watson is still quite accurate and 
a lot less expensive. For search, it’s a good, economical solution especially if you have a lot of video 
footage. 

Recording Your Audio

The higher the quality of your audio, the better the accuracy of the transcript. If someone is well mic’d 
in a sound proof room, you’re going to get better results than if you’re using the microphone on your 
iPhone on a busy, New York street corner.

The speech services do an amazing job but they can’t overcome garbage audio. Garbage in, 
garbage out.

This doesn’t mean it has to be perfect.

In fact, it’s rarely perfect and the transcriptions are still usually excellent (especially from 
Speechmatics). However, the closer you follow the below guidelines, the better chance you have of 
getting a highly accurate transcript. 

The Microphone

A good microphone goes a long way. So if you have your talent speaking into a good mic, even if 
you’re on a street corner (maybe not the busiest New York street corner ever, let’s not push it), the 
transcript should still come out excellent.

Our favorite microphone is the Behringer Ultravoice Xm8500 Dynamic Cardioid Vocal Microphone. 
You can get it for $20 and it’s great. Omni-directional mics pick up more noise. They can be great, the 
Sennheiser ME2 lav mic we have is awesome, but good ones are more expensive and, regardless, 
they pick up more noise.  

Background Noise

The less background noise the better. The quieter you can get the space you’re recording in to be, the 
better off you’ll be. However, all background noise is not created equal. White noise (waves crashing, 
cars passing) is less problematic than being in a room with lots of people talking.  
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Noise Reduction

Do NOT use noise reduction software on your audio. It will make the transcription worse. The AIs are trained with normal 
recordings, so the noise reduction software distorts what they’re expecting and the resulting speech-to-text is worse. (Machine 
learning works by giving an AI test data that it can learn with. It will do a better job with files that are similar to the files it 
learned on. So if it’s been trained with recordings with normal noise, it’ll do less well on recordings that have been manipulated 
to not have noise.) 

Talent That Can Enunciate

The speech services can handle accents. It’s really not a problem if you have a British, Indian or American accent.

Enunciation on the other hand... that matters. If you’re interviewing a drunk southern boy, the transcription will probably fare 
worse than your interview of that English barrister.

Try to get your talent to speak as clearly as possible. Again, it doesn’t have to be perfect. If they speak a bit fast or use a little 
slang, it should still result in a good transcription. But the further away you get from clear, well enunciated language, the worse 
the transcription is going to be.
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